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Commercial Design Using Autodesk Revit 2027

Lesson 3

FLOOR PLAN (First Floor):

In this lesson, you will draw the first floor plan of an office building. The office building will
be further developed in subsequent chapters. It is recommended that you spend adequate
time on this lesson, as later lessons build on this one.

Project Overview

A project’s space program is developed in the pre-design phase. Working with the client (or
user group), the architect gathers as much information as possible about the project before
starting to design.

The information gathered includes:
® Rooms: What rooms are required?
e Size: How big do the rooms need to be? (e.g., toilets for a convention center are much
bigger than those for a dentist’s office.)
e Adjacencies: This room needs to be next to that room. (e.g., the public toilets need to
be accessible from the public lobby.)

With the project’s space program in hand, the architect can begin the design process.
Although modifications may (and will) need to be made to the program statement, it is used
as a goal to meet the client’s needs.

You will not have a program statement per se for this project. However, the same
information will be provided via step-by-step instructions in this book.

Project Overview

You will model a three-story office building located in a rural setting. For the sake of
simplicity, the property is virtually flat.

The main entry and parking are
from the south side of the
building. You enter the building
through a three-story atrium.
Levels 2 and 3 have guardrails
that look down into the atrium
lobby on Level 1. The atrium is
enclosed on three sides by full-
height curtain walls (glass walls).
See the image on the front cover.
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L

This building is not meant to meet any particular building code. It is strictly a tool for
learning to use Revit. Having said that, the book includes several general comments on how
codes may affect a particular part of the design throughout.

The floor plans are mostly open office areas with a few smaller rooms for toilets, private
offices, work and break rooms, etc. These areas have several “punched” window openings
on the exterior walls (punched as opposed to ribbon windows).

FIGURE 3-1.1 Level 1 floor plan preliminary concept sketch
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FIGURE 3-1.2 South elevation preliminary concept sketch
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FLOOR PLAN (First Floor)

Exterior Walls

You will begin the first floor plan by drawing the exterior walls. Like many projects, you
might not be certain what the exterior walls will be eatly on. So, we will start out using the
generic wall styles. Then you will change them to a custom wall style (that you will create)
once you have decided on the wall construction.

New Project X

Adjust Wall Settings
Template file
1. Start a new project defaull.te -

[ ] Cth New Create new

e Click the Browse button O Project e

e Sclect Default.rte, click Open oK Cancel Help
e (lick OK

o Warning: Be sure to select the correct template as this is the basis for the
remainder of the book.

The previous chapter started with a more complete template. This chapter starts from the
default template, giving you the opportunity to learn how to create things such as the room
tinish schedule, so you can better understand how Revit works.

2. Select the Wall tool from the Ribbon and then make the following changes to the wall
options (Figure 3-2.1):
o  Wall style: Basic Wall: Generic — 12"
e Heght: Unconnected
e Height: 36' 0"
o [ pcation Line: Finish Face: Exterior
e Chain: Checked

s
QE o<~ -SH|H|=-50A
Architecture ~ Structure  Concrete  Steel  Systems  Insq # Add-Ins
- -
T Cope - |‘—'| & Offset 0 0" ﬁ )
% EjEl 4 £ O] x {1 / o O G O IE ~ I Height| = Unconnected -
Qcut > &= %%~ $ e (G @ Radius A
Modify Q E! . s Activate 1 . — Join Auto ¥ Depth I 36 o~
- By @oin- A §> 5 B BSLS <|status /7 Chain Join
Select ¥ Properties  Clipboard Geometry Controls § Draw Constraint vels
Properties X [ Level 1 3
¢
{
:l Basic Wall g
Generic - 12" 3
New Walls v @ Edit Type i
Constraints N i
Location Line Finish Face: Exterior 14
s WM

FIGURE 3-2.1 Ribbon, Properties Palette, and Type Selector: Wall tool active
Draw the Exterior Walls

3. Draw the walls shown in Figure 3-2.2. Make sure your dimensions are correct. Use
the Measure tool to verity your dimensions. Do not add the dimensions.
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NOTE: If you draw clockwise, your walls will have the exterior side facing the correct direction. You can also use the
Spacebar to toggle which side the exterior face is on. Position your building in the center of the exterior elevation tags.

9 -4 140'- 0"

FIGURE 3-2.2 Exterior walls

Create a Custom Wall Style

rd r
’ 1
%
o
N
& &
N 8
by
?3
®
o
AN
54'- 0" 32 - 0" 54'. 0"
i z||’ 4|’ i

Revit provides several predefined wall styles, from metal studs with gypsum board to
concrete block and brick cavity walls. However, you will occasionally need a wall style that
Revit has not provided in the template. You will study this feature next.

First, you will quickly review a more complex
wall type in Revit to see how it is set up.

4. With the Wal// tool selected, pick the
wall type Basic Wall: Extetior —
Brick on CMU from the Type Selector
drop-down list. (See image at right.)

5. Click the Edit Type button on the
Properties Palette (Fig. 3-2.3).

6. You should be in the Type Properties
dialog box. Click the Edit button
next to the Stucture parameter

(Figure 3-2.4).

BEeerdHo <

"SH[H[=-50 A0

Architecture  Structure  Concrete  Steel  Systems  Insert  An
[} ! % el B
El g e . B ID
bt = @
Modify Activate
M e @ s <
Select ¥ Properties  Clipboard Geometry Controls
Properties X D Level 1 x
:IBasicWall
Generic - 12"
O, sear
Basic Wall 2

=== Exterior -
— s
== Exterior -

Exterior -

+ Exterior -

! Exterior -

Foun:

34

4 Exterior -

Brick and CMU on MTL. Stud
Brick on CMU N «
Brick on Mtl. Stud
CMU Insulated

CMU on Mtl. Stud

EIFS on Mtl. Stud

Cqpn




FLOOR PLAN (First Floor)

Apply

Properties X Type Properties X
B Basic Wall . Family: System Family: Basic Wall v Load...
Exterior - Brick on CMU
Type: Exterior - Brick on CMU v Duplicate...
Rename...
Constraints o~
Location Line Type Parameters
Base Constraint Parameter Value =
Base Offset
Base is Attached Structure Edit...
Base Extension Distance 00" Wrapping at Inserts Srpreee W d
Top Constraint Unconnected Wrapping at Ends None
Unconnected Height 36" 0" (Width 1 71/2"
Top Offset 0 0 Function Exterior
Top is Attached
Top Bxension Distance 0" 0" Coarse Scale Fill Pattern
RebirReUag Coarse Scale Fill Color [ Black
Related to Mass
Cross-Section Definition 2
) . Structural Material Concrete Masonry Units
Cross-Section Vertical
Reference &
Hosted Thermal Transmittance (U) 0.0316 BTU/(h-ft"°F)
Structural 2 Thermal Resistance (R) 31.6278 (h-ft*°F)/BTU
Strictil Thermal Mass 28.646231 BTU/(ft>°F)
Structural Usage Non-bearing Amoiptance L0000,
Dimensions 2 Boughness 3
Area
Volume Type Image
Identity Data & Ikeynote
Image
Comments

Ca

<< Preview

incel Apply

FIGURE 3-2.3 Properties Palette

FIGURE 3-2.4 Type Properties

7. Finally, you are in the Edit Assembly dialog box. This is where you can modify existing
wall types or create new ones. Click <<Preview to display a preview of the selected

wall type (Figure 3-2.5).

Edit Assembly
) Family: Basic Wall
@& Type: Exterlor - Brick on CMU
=} Total thickness: 1' 7 1/2" (Default) Sample Height: 20 0
=z Resistance (R): 31.6278 (h-ftz-°F)/BTU
[} Thermal Mass: 28.6462 BTU/(ft>-°F)
b L
_8 aers EXTERIOR SIDE
Structural
Function Priority Material Thickness U Variable
Material |
_ :
2 |Thermal/Air Layer 3 Air 03 [] O
3 |Thermal/Air Layer 3 Rigid insulation 0 3" ] ()
O 5 0 A 1 o 5 o
i 5 1 9o 0 I 4 |Membrane Layer Damp-proofing 0' 0 -] @]
5 |Core Boundary Layers Above Wrap 00"
6  |Structure 1 Concrete Masonry Units 0" 7 5/8" ] O
7  |Core Boundary Lavers Below Wrap o0 i
INTERIOR SIDE
Insert Duplicate Delete Up Down
Default Wrapping
At Inserts: At Ends:
Do not wrap ~ None ~
Modify Vertical Structure (Section Preview only)
Modify Merge Regions Sweeps
Assifill avers Split Region Reveals
oK Cancel Help
» & View: Floor Plan: Modify ty -

FIGURE 3-2.5 Edit Assembly
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Here, the Edit Assenbly dialog box lets you change the composition of an existing wall or
create a new one.

Things to notice in the Edit Assembly dialog box (Figure 3-2.5):

The exterior side is labeled at the top and the interior side at the bottom.

You will see two horizontal rows (i.e., the Core Boundary) that identify the core
material.

What is the Core Boundary?
It is typically the structural part of the wall. If a wall only has one layer, it must be
within the core boundary.

The core material can be used to place walls and dimension walls. For example, the
Wall tool will let you draw a wall with the intetior or exterior core face as the
reference line. On an interior wall, you would typically dimension to the face of
CMU rather than to the finished face of gypsum board. This is to work out the
masonry coursing and provide the contractor with the information needed for the
part of the wall they will build first.

10.

11.

12.

13.

Each row is called a layer. By clicking a layer and using the Up or Down buttons, you
can reposition materials (i.e., layers) within the wall assembly.

Click Cancel in each open dialog box to close them (don't close the Properties Palette).
Set the wall style back to Basic Wall: Genetic — 12" in the Type Selector.

Click the Edit Type button again on the Properties Palette.

Click Duplicate.

Enter Brick & CMU cavity wall for the new wall type name, and then click OK
(Figure 3-2.6).

Name X

Name: Brick & CMU cavity wall

Cancel

FIGURE 3-2.6 New wall type name

Click the Edit button next to the S#ucture parameter.
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FLOOR PLAN (First Floor)
]

14. Using the Insert button and the Up and Down buttons, add the /ayers to your new
wall style, as shown in the table below (Figure 3-2.7).

Function Priority | Material Thickness

Finish 1 4 Brick, Common 4"
Thermal/Air Layer 3 Air 2
Thermal/Air Layer 3 Rigid insulation 2"
Membrane Layer Damp-proofing 0"

Core Boundary Layers above wrap 0”
Structure 1 Concrete Masonry Units 8"

Core Boundary Layers below wrap 0”
Substrate 2 Metal Furring 21/2"
Finish 2 5 Gypsum Wall Board 5/8"

FIGURE 3-2.7 New wall layers

Masonry is sometimes drawn nominally in floor plans. This helps to figure out coursing for
both drawing and dimensioning. Note that 8" concrete block is actually 7%s".

Also, notice that the CMU, Rigid Insulation, Air Space and Brick add up to 16" in thickness.

This portion of the wall would sit on a 16" concrete block (CMU) foundation wall directly
below.

15. Your dialog should look like Figure 3-2.8. Click OK to close all dialog boxes.

Edit Assembly X
Family: Basic Wall
a Type: Brick and CMU cavity wall
= Total thickness: 1' 7 1/8" (Default) Sample Height: 20' 0"
i Resistance (R): 21.8824 (h*ft2-°F)/BTU
B, Thermal Mass: 34.0106 BTU/(ft2-°F)
Layers
EXTERIOR SIDE
Structural
Material Thickness e e Variable
Material
1 ) 4
2 [Thermal/Air Layer 3 Air 0 2" @]
_ EM ermolFii taver. B loid s ation ¢ = )
4 Layer Damp-proofing 00 @]
A 5 CHSReid) LaysisRbowe Winp SRR V03
Y% OSSO S S | 6 |Structure 1 Concrete Masonry Units ' 8" ] O
>%>b<>< 7 |Core Boundary Layers Below Wrap 00
>>é Seleds X b > % QR % 8 |Substrate 2 Metal Furring 02120 @ O
XK X 9 [Finish 2 5 Gypsum Wall Board oos58 @ O
INTERIOR SIDE
Insert Duplicate Delete Up Down
Default Wrapping
At Inserts: At Ends:
Do not wrap v None v
Modify Vertical Structure (Section Preview only)
Modify Merge Regions Sweeps
Assign Layers Split Region Reveals
[ oK Cancel Help
a4 e View: Floor Plan: Modify tyr Preview >>

FIGURE 3-2.8 Edit Assembly for new wall type
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The next step is to change the wall type for the previously drawn walls.

16. Select the Modify button on the Ribbon; this cancels the active command and allows
you to select elements in your drawing.

17. Zoom out so you can see the entire plan. Dragging your mouse from one corner to
the other, make a window over the plan to select all the walls. Be careful not to select
the exterior elevation tags — move them away from your building first if needed.

18. With the walls selected, pick Baszc Wall: Brick & CMU cavity wall from the Type
Selector drop-down list.

TTIP: 1If, after selecting all the walls, the Type Selector is not active and shows no wall types, you probably have the
excterior elevation tags selected. If needed, click and drag the elevation tags away from the building to make the
walls easier to select, but do not delete them. You can also click on the Filter button (located on the Ribbon when
objects are selected) and uncheck the types of elements to excclude from the current selection.

You should notice the wall thickness change,
but the wall cavity lines and fill patterns are
not showing yet. This is controlled by the
Detail 1 evel option for each view.

25 Medium
Fine

19. Click on the Detail Level icon in the
lower-left corner of the Drawing
Window, on the View Control Bar.

Detail 1 evel; Set to Medinm

20. Select Medium.

You should now see the brick and CMU thicknesses, along with their fill patterns. If you did
not draw the walls clockwise, some of your walls may show the brick on the inside of the
building.

21. Select Modify (or press Esc); select a wall. You will see a symbol that lets you flip
the wall orientation by clicking it (Figure 3-2.9).

B ) B

Click this symbol to flip

wall orientation

FIGURE 3-2.9 Selected Wall; notice some walls have the brick on the intetior
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FLOOR PLAN (First Floor)

22. Whether you need to adjust walls or not, click on the flip symbol to experiment with
its operation.

T1P: The Flip symbol is always on the exterior side (or what Revit thinks is the exterior side) of the wall.

23. If some walls do need to be -
adjusted so the brick is to the 1-1-)

exterior, do it now. You will TIP: You can use the MOVE tool Move oz the

probably need to select the Ribbon (when a wall is selected) to accurately move walls.
wall(s) and use the temporary

dimensions or move tool to Follow these steps to move an object:
reposition them to match the o Select the wall
required dimensions. o Click the Move too!
o Pick any point on the wall
TIP: If you set the “location line” in the o Start your cursor in the desired direction (don’t
Properties Palette to "W all Centerline,” click)
the wall will not move or alter the overall A

Start typing the distance you want to move the
dimensions when flipped. Y ou will want to wall and press Enter.

set the “location line” back to Finish
Face: Excterior when done.

Finally, you will convert the three walls in the atrium into curtain walls (full glass). This will
let a lot of light into the atrium and better identify the building's main entry.

24. Drag a selection window (from left to right) to select the three walls around the
atrium, or hold the Cttl key on the keyboard and select them.

25. With the walls selected, pick Curtain Wall: Curtain Wall 1 from the Type Selector drop-
down. FYT: the walls will not touch at the corners until mullions are added in a later
step.

Your atrium is now surrounded by curtain walls (Figure 3-2.10). In a later lesson, we will add
horizontal and vertical mullions to the curtain wall.

on the OAT. Notice that Revit shows the curtain wall as transparent because
it recognizes it as glass. The other walls are shaded on the exterior side due
to the brick pattern.

You can see your progress nicely with a 3D view. Click the 3D View button @
v

26. Save your project as ex3-2.rvt.
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Revit automatically sets the fill pattern intensity (i.e., material representation within each
layer of the wall) and line weights.

a
Kl
f
H
H
H

-
A
¥
il

bli
]
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d
————
———
i
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B
=

FIGURE 3-2.10 Completed exercise (Level 1 plan view)

FIGURE 3-2.11 Completed exercise (default 3D view)
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FLOOR PLAN (First Floor)

Interior Walls

In this lesson, you will draw the interior walls for the first floor.

Adjust Wall Settings

1. Inthe Level 1 floor plan, select Architecture = Build = Wall from the Ribbon.

2. Make the following changes to the wall options on the Ribbon, Properties, and Type
Selector (Figure 3-2.1):

e Wall style: Basic Wall: Intetior — 4 7/8" partition (1-hr)
o Hejght: Level 2
o [ ocation Line: Wall Centerline

Draw the Interior Walls

3. Draw a “vertical” wall approximately as shown in Figure 3-3.1. You will adjust its
exact position in step #4.

Step #4 (second click): pick

left side of this wall \

Step #4 (first click): pick the
edge of this wall

FIGURE 3-3.1 First interior wall

4. Select Modify = Modify = Align tool to align it with the edge of the

exterior wall in the atrium (Figure 3-3.1). When you are done, the wall .[:]
should look like Figure 3-3.2.
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5. Create the same wall for the West side of the atrium,
repeating the above steps.

Modify an Existing Wall Type

Next, you will add some additional interior walls. You will be drawing
8" CMU walls. Revit does have an 8" Masonty wall type available in
the default template file that you started your project from. However,
the thickness for this wall type is 7%s", which is the actual block size.

Floor plans are sometimes drawn nominally (i.e., 8”), not actual
(7%s"). This is done so you can determine the masonty coursing,
minimizing cutting (and associated extra material and labor costs).
Therefore, rather than creating a new wall type, you can simply
modify the existing wall type. Some firms prefer to use actual
masonry dimensions. However, these changes should still be made to
this project so you learn more about how walls work and so all the
tasks in this book work as expected or intended.

FIGURE 3-3.2
First interior wall

6. In the Wall command, select the wall type Basic Wall:
Generic — 8" Masonry.

7. Select the Edit Type button on the Properties Palette to view the wall’s Type Parameters,
and then click Edit next to the S#ucture parameter.

8. Change the masonry thickness from 7%s" to 8" in the Edit Assembly dialog box, and
then select OK to close each dialog.

Occasionally, Revit will not list dimensions relative to the walls you want to draw new walls
from, while in the “create wall” mode. One way to deal with this is to draw temporary Detail
Lines to use as a reference. After using the temporary line as a reference, you can delete it.

9. Select Annotate > Detail > Detail Line /ot annotste  Anslyze  Massing & Site cj

from the Ribbon; the line type does not really

] :ion Detail Line £ Revision Cloud A T
matter, but select a continuous one called

:_iinate Region ~ Detail Group ~ % Cw‘
T e T ) 3
Thin Lines” via Line Style on the Ribbon. } Cnporaed = 1 fneibiion ®, F"i
Detail

10. Draw the “vertical” line, 35’-0” long, as
shown in Figure 3-3.3; be sure to snap to
the Midpoint of the atrium wall as your first point.

Next, you will draw an elevator shaft, centered on the atrium and 35'-0" back. The
temporary line will help position it in the center; then we will delete the line.

The inside dimensions of the elevator are 7'-4" x 6'-10". Since you know the inside
dimensions, you will want to adjust the location line to match the known information.
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_________________________________________________________________________________________________________________________________________|]

11. Activate the Wa/l tool with Generic — 8" Masonry selected in the Type Selector.

12. Set the Location Line to Finish Face: Interior.

13. Draw the 7'-4" x 6'-10" "

elevator shaft. Make sure
S Step 13:

the location line is to the Elevator shaft added in :
inside so your shaft is the approximate location. T P
correct dimension. Draw ' ‘
the shaft anywhere in the
Drawing Window, you will
adjust the exact position
next.

FYT1: Use the Measure tool to
donble-check the dimensions.

14. Select the 4 walls that
represent the elevator
shaft, and then pick the — N .
Move tool. 8

Step 10:

First pick, using the
midpoint snap

16'-0 16'-0"

FIGURE 3-3.3 Temp. Detail Line

T1P: Concrete blocks come in varions widths, and most are 16" long and 8" high. When drawing plans, there is a
simple rule to keep in mind to make sure you are designing walls to masonry coursing. This also applies to wall lengths

and openings within CMU walls.

Dimension rules for masonry coursing in floor plans:
e ¢“0” ore8” where e is any even number (eg., 60" or 24"8")
o 9’4" where 0 is any odd number (e.g., 5"4")

15. Snap to the Midpoint of the shaft as your first point, and then snap to the Endpoint of
your temporary detail line (Figure 3-3.4). You should zoom in to verify your snaps.
Do not draw the dimensions; they are for reference only.
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The elevator shaft is now perfectly centered in the
atrium and exactly 35’-0" back from the South

curtain wall. r-4" Y
16. At this point, you can delete the temporary =
line. Select the line and then right-click and .
©
select delete, or press the Delete key on the
keyboard. v
," First pick, using the
,/ midpoint snap

\ Second pick, snapping to

the line’s end

FIGURE 3-3.4 Move elevator shaft into place

FYI: When a wall is selected, you can see that wall’s properties via the Properties Palette (Type “PP” 10 open the
Palette if it is not visible). Click one of the elevator shaft walls and verify that it is 360" tall.

Modify an Existing Wall

Next, we want to change the portion of the wall between the building and the Fast and West
stair shafts. To do this, you will need to split the current wall, trim the corners, and then
draw an 8" masonty wall.

17. Zoom in on the West stair shaft and select the Split Element tool C I:
(Modify tab on the Rzbbon).

18. Pick somewhere in the middle of the wall (Figure 3-3.5).

19. Select Modify = Modify = Trim to trim the corners so the exterior
wall only occurs at exterior conditions (Figure 3-3.6). 1

TTIP: Select the portion of wall you wish to retain.
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= |

X
X

Step 18:
Split the wall in this

approximate location.

Y

/

13- 0 7mA"

.
ol

PN NN N NN

FIGURE 3-3.5 Split tool FIGURE 3-3.6 Trim tool

Additional Custom Wall Types

We decided that the stair shafts are mostly utilitarian and do not require gypsum board on
the walls. In the next steps, you will create a new exterior wall type similar to the one
previously created, without gypsum board or metal studs. Also, you will create a custom wall
type to close the open side of the stair shaft we created in the previous steps. This wall type
will have gypsum board and metal studs on one side.

20. Using the wall type Basic Wall: Brick & CMU cavity wall as a starting point, create a
new wall type named Brick & CMU cavity wall (no GWB). Remove the gypsum
board and metal studs, and save the new wall type. (Reminder: Edit Type and Duplicate.)

21. Change the three exterior walls around the west stair shaft to the new wall type
created in the previous step (select them and pick from the Type Selector).
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22. Using the wall type Basic Wall: Brick & CMU cavity wall as a starting point, create a
new wall type named 8" Masonry with GWB 1S. Remove the brick, air space, rigid
insulation and membrane layer and save the new wall type (Figure 3-3.7).

FYI: 1t will be useful to come up with a standard naming system for your custom wall types. If the names

get too long they are hard to read. The exanmple above has:
» GWB = Gypsum Wall Board (and would imply studs)
* 185 = finish only occurs on one side of the wall.

Function [Priority] Material Thickness

n/a n/a n/a

Core Boundary Layers above wrap k4

Structure [1] Concrete Masonry Units "

Core Boundary Layers below wrap 0”

Substrate [2] Metal Furring 21"

Finish 2 [5] Gypsum Wall Board 5"

FIGURE 3-3.7 New wall layers
23. Draw a wall so the gypsum finish continues on the

office side, using the A/gn tool if necessary (Fig 3-3.8).

Tip: Use the Measure tool to make sure the stair shaft is the
correct size; don’t draw the dimensions.

Next, you will use the Mirror tool to update the east stair.
Before doing so, you will draw a Reference Plane to use as the
Axis of Reflection (more on this later when using the Mirror

tool).

24,

25.

20.

27.

Select Architecture = Work Plane = Ref Plane
from the Rzbbon.

Draw a Reference Plane snapped to the vertical, centered
on the South atrium wall (See Figure 3-3.9).

Erase the four walls of the East stair shaft; this will

include the main east wall of the office building
(Figure 3-3.9).

TIP: Select the walls and press Delete on the keyboard.

Select the six walls at the West stair (Figure 3-3.9).

6

TTIP: Make sure the count is corvect on the Status Bar.

3-16
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FLOOR PLAN (First Floor)

28. Select the Mirror - Pick Axis tool (on the Ribbon) and then select the
Reference Plane (Figure 3-3.9). A 'L}‘

Pick the
Reference Plane

|

|

|

|

I

|

as the axis of I
\AI
|

|

|

1

|

reflection

FIGURE 3-3.9 Mirror west stair

29. Use the Measure tool to verify the overall length of the building is 140"-0" (not
including the stair shafts). Adjust as necessary (see Fig. 3-2.2).

FIGURE 3-3.10 Mirrored west stair

Finally, you will draw a few more interior walls to complete the first floor plan. Do not
delete the Reference Plane (note: the reference line may not show up in every image in
this text).
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30. Using the Wall tool, set the wall type to Basic Wall: Interior — 4 7/8" partition
(1-hr).

31. Draw the additional walls shown in Figure 3-3.11. Make sure to position the walls
per the dimensions shown. Use the Measure tool to verify accuracy. Also, modify the
Location Line as required.

DRAWING TIPS: Copy the existing atrinm wall 6”4 7/s” over (60" plus one wall thickness), draw a wall from the
midpoint of the elevator shaft with centerline reference (Location Line), and use the Trim and Mirror tools. Do not
draw the dimensions. SAVE YOUR PROJECT as ex3-3.tvt.

7 N N NN A YA

z 14
°| <
' L
i -
©lo
6! - OII 6' - 0"
5| X
CLEAR O CLEAR
o | 4
- | O
’\(‘/ <
< <
< N
< X

FIGURE 3-3.11 Remaining interior walls
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Exercise 3-4:
Elevator

This lesson shows you how to install an elevator in your elevator shaft.

Insert Elevator

Revit provides many Famsilies, which are predefined elements ready to insert into your
project. However, many elements are not readily available, such as elevators. You will get an
elevator family online in this exercise. The online library is where you will acquire an elevator

family for use in your project.
Project Browser - ex3-3.rvt X

. O EBS YR @
1. Open project ex3-3.rvt and Save As ex3-4.rvt.

1+++++++++++++++++++++++++++++++++++@,O

Families Lod
Analytical Links

Annotation Symbols

You will have to download the elevator from the web. Of

course, you will need to be connected to the Internet. i
able Trays

Ceilings
Columns
Conduits

2. Click on the Insert tab on the Ribbon.

Curtain Panels
Curtain Systems
Curtain Wall Mullions

3. Select Load from Library=> Load Autodesk
Family from the Ribbon.

Detail Items
Division Profiles
Doors

4. Search for Elevator-Electric, select it, and then
click Load to import the family into your project
(an internet connection is required for this step).

Duct Systems
Ducts

Flex Ducts
Flex Pipes
Floors

Furniture

5. In the Project Browser, click the Families filter to
narrow down the list (Figure 3-4.1).

Generic Models
Parking

Pattern

Pipes

Piping Systems

6. Expand the Vertical Circulation list, and then

. Planti
Elevator-Electric. e

Profiles
Railings
As you can see, four elevator types were loaded into your -
project. Like wall types, you can add one of these types as-
is, or modify or create a new one. Next, you will add

information in the Type Properties dialog to better document

the elevator being specified.

Roofs

Stairs

Structural Beam Systems
Structural Columns
Structural Foundations
Structural Framing
System-Zones
Toposolid

7. Right-click on the elevator type 2000 1bs, and then e %‘

select Type Properties from the pop-up menu. 2000 s
2500 Ibs
3000 Ibs

You will now see a listing of the type properties for the 3500 Ibs
selected elevator type. — ¥

FIGURE 3-4.1 Elevator family:
Project Browser
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8. Click the Preview button (if necessary) to see the graphical review of the elevator
type. Set the [7ew to 3D View: View 1.

9. Add the following information (Figure 3-4.2):

o Model: MadeUp 8864
e Manufacturer:  ThyssenKrupp Elevator
e URL: www.thyssenelevator.com

This data just entered represents the I in BIM (Building Information Modeling).

Type Properties X
Family: Elevator-Electric W Load...
_/_;:\\‘ .
| "
@E Type: 2000 Ibs b Duplicate...
—5 Rename...
@ Type Parameters
b Parameter Value £
L)

Default Elevation

Type Image

Keynote

Model MadeUp 8864
,/\ Manufacturer ThyssenKrupp Elevator

Type Comments

URL www.thyssenelevator.com

I Description

Assembly Code

Cost

Assembly Description

Type Mark

OmniClass Number

OmniClass Title

Code Name

Cab Height 76"

Cab Location 12" 0"

Cab Width 6 0"

Depth 6 10"

Door Opening 30
- Pit Depth 4' 0"

Width 74"

sotoy: | £} 21 £l

@ @ View: 3D View: View 1 v Preview >> 0K Cancel Apply

FIGURE 3-4.2 Elevator properties

10. Click OK to close the open dialog box.
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11. Drag the 2000 Ibs clevator type from the Project Browser into the first floor plan.

FYI: You can also use the Component tool from the Architecture tab to place the elevator.
The elevator type will be attached to your cursor, ready for insertion.

12. Move your cursor within the elevator shaft and adjust it until the elevator “snaps” in
place, then click (Figure 3-4.4).

13. Press Esc twice to tell Revit you are finished placing elevators.

Now you need to add an elevator door in the shaft walls at = |7 e gpare o/
each level; it is similar to a regular door in a wall. — Specialty Equipment
= Elevator Door-Center
14. Load the Elevator Door — Center family using the 32" x 84"
Load Autodesk Family command again. ] L 3
42" x 84"

15. Drag the 36" x 84" clevator door type from the 48" x 84"
project browser into the first floor plan (Figure 3- 900 x 2100mm
4.3). + Stairs

+ Structural Beam Systems

16. Place the elevator door at the center of the wall, + Structural Columns
aligned with the elevator door on the cab (Figure 3- + Structural Foundations
4.4). + Structural Framing

+ Toposolid

TIP: If the door is inserted on the wrong side of the wall, select the — Vertical Circulation
door and click the Control Arrows to flip it within the wall. =~ Elevator-Electric

2000 Ibs

2500 lbs

3000 lbs

3500 Ibs

et NG S ettt )

FIGURE 3-4.3 Elevator doors in
Project Browser
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FIGURE 3-4.4 Elevator door added to plan

Notice when the elevator is selected, the flip icon (control arrow) is displayed. Similar to the
doors and walls, you can click this icon to flip the orientation of the elevator within the

shaft.

17. Save your project as ex3-4.rvt.
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Doors and Windows

This lesson will take a closer look at inserting doors and windows.

Insert Doors

Revit has done an excellent job providing several different door families. This makes sense,
seeing as doors are an important part of an architectural project. Some of the provided
families include single, double, pocket, sectional (garage), and vertical rolling, to name a few.
In addition to the families provided by Autodesk, many more are available on other websites
(some free, some not).

The default template you started with only provides the Sgl Flush (Single Flush) family in
the Doors category. If you want to insert other styles, you will need to load them from the
library. This step is necessary because when you load a family, Revit actually copies the data
into your project file. If every possible family were loaded into your project at the beginning,
not only would it be hard to find what you want in a large list of doors, but also the project
file would be several megabytes in size before you even drew the first wall.

You will begin this section by loading a few additional families into your project.
1. Open project ex3-4.rvt and Save-As ex3-5.rvt.

2. From the Insert tab, select the Load Autodesk Family button on the Rzbbon (Figure
3-5.1).

3. Browse through the various categories for a moment.

Architecture ~ Structure ~ Concrete  Steel  Systems  Insert Annotate Analyze Massing &Site  Collaborate  View Manage Add-lns  Modify @~

M AEEL B % ¢ B E WEBEES H

Modify| Manage Link Link Link Link DWF  Decal Point Coordination —Link Link Extended Import Import Import Import Load Load Autodesk Loadas  Insert
Links  Revit IFC CAD Topography Markup Cloud Model PDF Image Properties CAD gbXML PDF Image Family Family Group ~ from File
Select ¥ Manage Link Import 3 Load from Library

FIGURE 3-5.1 Load Family
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Each file represents a Family; next you will load four door Families into your project.

Load Autodesk

Filter Q| Search content names and paths '@' EE (D
Category @ @ 54 results for: Doors
Any v

Browse

< All Results

e Door-Curtain- Door-Curtain- Door-Curtain- Door-Double-
2 Wall-Double-.. Wall-Double-... Wwall-Single-.. Flush_Panel

Commercial

Hardware

Residential
Door-Double- Door-Double- Door-Double- Door-Exterior-
Flush_Panel-_ Glass Sliding Double
Door-Exterior- Door-Exterior- Door-Exterior- Door-Exterior-
Double-Full.. Double-_ Revolving-Full Side_Lite-Full .

= =i =

—
How do I find and load content? Cancel

FIGURE 3-5.2 Door families on hard drive

4. Open the Doors category and then select Door-

. . - B Famil
Curtain-Wall-Double-Storefront, and then click ;{'A::;t'j:l .
. L !
Load (Figure 3-5.2). + Annotation Symbols
+ Cable Trays
5. Using Insert = Load Family, load the following + Ceilings
SDC provided door families: + Columns
+ Conduits
a. Double-Glass 1 + Curtain Panels
b. Sldehghts 1 + Curtain Systems
c. Single-Glass 1 + Curtain Wall Mullions
+ Detail ltems
6. In the Project Browser, expand Families and Doorsto |-~ [D;Vism Beics
I . bt oors
see the loaded door families (Figure 3-5.3). T T T
o . + Double-Glass 1
If you expand a door family itself in the Project Browser, + Single-Flush
you see the predefined door sizes associated with that + Single-Glass 1
family. Right-clicking a door size lets you rename, delete, *+ Duct Systems
ot duplicate it. To add a door size, duplicate the item, FIGURE 3-5.3 Loaded doot families

then modify its properties.

Next, you will insert the doors into the stair shafts.

3-24



FLOOR PLAN (First Floor)
_________________________________________________________________________________________________________________________________________|]

7. Select the Door tool from the Architecture tab, and then pick Sgl Flush: 36" x 84"
from the Type Selector on the Properties Palette.

8. Insert two doors in the West stair shaft as shown in Figure 3-5.4. Remember you are
inserting a door into a masonry wall, so your door position and size need to work
with masonry coursing, thus the 8" dimension (however, you would also need to
include the door frame into the equation).

9. Repeat the previous step to insert doors into the East stair shaft.

10. Finish inserting doors for the first floor (Figure 3-5.5).
Use the following guidelines:

a. All doors should be 36" wide and 7'-0" tall.

b. You will not insert doors into the curtain wall for now. You will do thatin a
later lesson when you design the curtain wall.

c. Use the style and approximate location shown in Figure 3-5.5.

d. Doors across from each other in the two atrium walls should align with each
other.

TIP: While inserting the second set of doors, watch for the reference line to appear,
indicating alignment.

e. Place doors approximately as shown, exact location not given.

2 1

Ol _ 8"

<

FIGURE 3-5.4 Doors in West stair shaft
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(] |

Single-glass 1

Iype Properties

/

N

Sgl. Flush

Double-glass 1 I\;g |

|

Single-glass 1

E ‘/| Double-glass 1

|

FIGURE 3-5.5 First floor with doors

ramily; single-lush

36" X8 -

Type

@a

View: 30 View: View 1

[Thickness

Height

(Trim Projoction Bt
[Trim Projection It
Trien Wieith

widih

Rough Width
Rough Height

106520 BTU/AR )
Metal
115338 (ht-N/BTU

Heat Transter Cocfficient (U]

\Analytic Construction
[Thermal o ()

Anply

FIGURE 3-5.6 Door type properties
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Door Type Properties:

1f you select Edit Type while the
Door tool is active (selected),
you can modify various
properties related to the door.

You can easily add another
standard door size to the Family
as required. Click “Duplicate,”
and type a name (Figure 3-5.6).

Standard door sizes (and
Families) can be added to your
template file, so you don’t have
to load them for every new
project.
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Insert Windows

Adding windows to your project is very similar to adding doors. The template file you
started from already has three families preloaded: the Fixed, Double-Hung, and Casement.
In the Type Selector drop-down, you will see the available sizes for insertion. At this point,
you should also see the SIDELIGHT family that you loaded in the previous exercise. First,
you will add a few interior borrowed lights using the sidelight family.

Interior Windows (Borrowed Lights)

11. With the Window tool selected, pick Sidelights 1: 18" x
84" from the Type Selector.

12. On the West side of the atrium, insert the four
borrowed lights as shown in Figure 3-5.7; do not add
the dimensions.

Make sure the borrowed light frames are flush with the
atrium side of the wall. You can control that option by
moving your cursor to the side of the wall you want the frame
flush with before clicking to insert. After drawing the
window, you can select the frame and use the flip icon
(similar to doors and walls).

13. Repeat the previous steps to insert the borrowed
lights on the East side of the atrium.
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Exterior Windows

14. Using the methods previously covered in this book, create a new window size in the
FIXED family. Create Fixed: 32" x 48". You are creating this new size to fit masonry
coursing in the plan view. The largest window (preloaded) that fits coursing in the
plan view is 24".

15. Adjust the sill height for your new window size to fit within masonry coursing as
well. Set the sill height for Faxed: 32" x 48" to be 3'-4" (Figure 3-5.8).

Type Properties X

Family: Fixed ~ Load...
i Type: 32" x 48" b Duplicate...
) Rename...
@ Type Parameters
h Parameter
B
E: g Wall Closure By host
5
N Construction Type

Glass Pane Material |
Sash Material Sash

I Height 40"
Default Sill Height 34"
Width > g h
Window mset 0 U3/
Rough Width
Rough Height
Define Thermal Properties by Schematic Type
Visual Light Transmittance 0.900000
Solar Heat Gain Coefficient 0.780000
Heat Transfer Coefficient (U) 0.6496 BTU/(hft%-°F)
Analytic Construction 1/8 in Pilkington single glazing
Thermal Resistance (R) 1.5394 (h-ft2°F)/BTU
Assembly Code B2020100
Keynote

| et

Model
Manufacturer

oo A 4
sortby: |2} 2] %l
@ @ View: 3D View: View 1 ~ Preview >> OK Cancel Apply

FIGURE 3-5.8 New window size with modified window sill height

16. Insert a single window as shown in Figure 3-5.9. The window should be inserted
with masonry coursing in mind. Ensure Tag on Placement is active.

NOTE: The dimensions displayed while inserting the window will not match the conrsing dimensions
because Revit is measuring from the center of the adjacent excterior wall. Thus, you will have to insert the
window as close as possible and adjust its location, verifying with the Measure fool.
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Array Window I

The Array tool allows you to quickly copy //7 2 ) /@
several objects that have the same distance L~ [ —
between them. You will use the Aray tool -mq , -

to copy the windows:

17. Click the Modify tool and then select your

window.

18. With the window selected, pick the g
Array tool from the Modify tab. no

19. On the Ribbon, type 6 for the
Number field.

20. Click the left mouse button at

the midpoint of the window and :E—@

move your mouse to the FEast until

the dimension displayed is 8'-6". 3. 4" @
7

21. You should now see the windows arrayed in the  FigURE 3-5.9 Exterior window

wall. 8'-6" is not coursing, so select the Activate
Controls & Dimensions button on the Rzbbon
and then enter 8'-8" in the displayed dimension r_‘gﬂ
to adjust the window openings. This allows you
to more accurately adjust the dimensions.

Activate

Controls

FIGURE 3-5.10 Window to be arrayed

S

S =
19)

FIGURE 3-5.11 Window after array
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22. Place the windows on the three remaining walls of the first floor (Figure 3-5.12).
Consider the following:

a. This would be a good use for the Mirror tool.

b. You can use the Reference Plane to mirror the windows in the East-West
direction.

c. Create a horizontal reference line for a mirror reflection axis in the North-
South direction.
Use the Measure tool to verify accuracy.

e. Use the Ctrl key to select multiple windows.

1 ™

BV B B BE—1 EB—1 5 10 BT B B B—1 B—1

o i

(&) © ‘E (&5) @

e e B BV B B B

FIGURE 3-5.12 Completed window layout

Cleaning House: = Windows
= Fixed
As previously mentioned, you can view the various Families and types 16" x 24"
loaded in your proj.ect. Th§ more Families and Types you have lqaded 16" x 48"
the larger your project file is, whether or not you are using them in your . .
. .. . . 16" x 72
project. Therefore, it is a good idea to remove any doors, windows, etc., . .
that you know you will not need for the current project. 24" x 24
24" x 48"
24" x 72"
) ) . . 32" x 48"
23. In the Project Browser, navigate to Families 2 Windows = I
Fixed. Right-click on 36" x 48" and select Delete. P
- 36" x 48
36" x72"
FIGURE 3-5.13 Project Browser

24.  Save your project.
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Self-Exam:

The following questions can be used as a way to check your knowledge of this lesson. The
answers can be found at the bottom of this page.

1.

2.

The Rizbbon allows you to set the height of a wall when first drawing it. (T/F)

It is not possible to draw a wall with the interior or exterior face of the core as the
reference point. (T/F)

Elements cannot be moved accurately with the Move tool. (T/F)

The tool, in the Rzbbon, has to be selected in order to select an element in
your project.

A wall has to be to see its flip icons.

Review Questions:
The following questions may be assigned by your instructor as a way to assess your
knowledge of this section. Your instructor has the answers to the review questions.

1.

Revit comes with many predefined doors and windows. (T/F)

The length 3'-8" is a masonty dimension. (T/F)

You can delete unused families and types in the Prgject Browser. (T'/F)
It is not possible to load families and types from the internet. (T/F)

It is not possible to select which side of the wall a window should be on while you
are inserting it. (T/F)

What tool will break a wall into two smaller pieces?

The tool allows you to match the surface of two adjacent walls.

Occasionally you use the Split Element command to turn one wall into two walls.

(T/F)

You can use the tool to copy an element multiple times in one
step.

10. The template file has a few doors, windows and walls preloaded in it. (T/F)

SELF-EXAM ANSWERS:
1-T,2-F,3-F, 4—Modify, 5 — Selected
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Notes:
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